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Chapter-1 
Overview of Computerised Accounting System (CAS) 

(Focused Area Only) 
 

 

 

 

 

 

 

Computers are widely used in all business today. They normally used in business 

houses to record business transactions, prepare wage sheet, inventory control, 

prepare final accounts etc. Computerised accounting is the process of recording 

business transactions and generating financial statements and reports with the help 

of computers and various accounting softwares. In simple words, accounting with the 

help of computers is called computerised accounting. 

Features of computerized accounting system 

1. Simplicity: Computerized Accounting System (CAS) is an easy way to process the 

accounting transactions. In CAS, the job of an accountant is only to enter accounting 

transactions through appropriate vouchers. Let the computer do all other works itself.  

2.Comprehensive nature: Most of the accounting packages are complete and 

comprehensive. They can handle various types of vouchers, day books, different 

registers, final accounts etc. 

3. Accuracy: The reports that are generated by computerized accounting system are 

free from mistakes. This is because computers can carry out even complex 

calculations at high rate of accuracy. 

4. Speed: Computers can process data millions of times faster than human beings. 

5. No difficulty in alterations: Alterations and additions in transactions can be 

affected easily in computerized accounting. This helps to provide changed results 

instantly. 

6. Storage and retrieval of data is very easy: Under computerized accounting, a 

large volume of data can be stored in a very small space;  further quick retrieval of 

data from the system is easily possible. 

Chapter-1 Overview of Computerised Accounting System, Focused Area-2022 

Examination 

1. Computerised Accounting System - Meaning 

2. Features of Computerised Accounting System (CAS) 

3. Components of CAS 

4. Codification of Accounts- Types of codes 

5. Merits and Demerits of CAS 
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7. Preparation of bank reconciliation statement:Preparation of bank reconciliation 

statement is possible in CAS. Hence an organization can reconcile its cash book 

balance with bank balance. 

8. Voucher and cheque printing: CAS helps in printing cheques, debit note, credit 

note, invoices etc. 

Components of computerized accounting system (Five Pillars 

ofComputerised accounting system) 
The computerized accounting system have five components, namely procedure, 

data, people, hardware and software. They are regarded as five  pillars of 

computerized accounting system. 

1. Procedure: A logical sequence of actions to perform a task. 

Example for Procedure in Accounting: (Identifying business transaction-----

collect its source documents-------journalizing-----posting-----trial balance-----

consider adjustments------prepare final accounts) 

2. Data: Data refers to raw facts. Data is a collection of facts, such as numbers, 

words, measurements, observations or just descriptions of things. When data 

are processed, organized, structured or presented in a given context so as to 

make them useful, they are called Information 

3. People (Human ware): Human ware are persons who operate the computer. 

They include users like owners, managers, system analyst, data entry operator, 

etc. 

4. Hardware: All physical components associated with a computerized 

accounting system are referred to as hardware. It includes CPU, monitor, 

mouse, printer, scanner, modem etc. 

5. Software: Software is a set of instructions that tell a computer what to do.It 

comprises the entire set of programs, procedures, and routines associated with 

the operation of a computer system. Software includes system software like 

Windows, Linux etc. and application software like Tally, Dac Easy etc. 

Data and Information 
Data: Data are raw facts that are stored in a computer. In accounting data comprises 

of one or more elements relating to a transaction. It is unorganized facts so it needs 

to be processed.  

Eg:11-09-2020 Sold goods to Bimal Rs.20,000.When we record this transaction to the 

computerised accounting system, we provides lot of data to the system like date, 

debtor details, debit item, credit item, amount etc. 

Note: A transaction consists of four data elements such as name of accounts, date 

of transaction and amount. 

➢ Name of the account (Debtor) 
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Assets = Equities  

Assets: The properties owned by the business are called assets. 

Equities: Total clam against the business are called equities. Equities can be sub-

divided into two as owners claim i.e capital and outsiders claim i.e liability. 

Assets – Liabilities = Capital 

Assets – Capital = Liabilities 

Assets- Capital- Liabilities = Zero 

Every business transaction will affects assets, liabilities or capital. For example, a 

transaction, say, purchased goods from A Ltd on credit; it will increase the value of 

stock (Asset) and also will increase the amount of creditor (Liability). 

The claims of owner’s keep on changing due to profit or loss of the firm. Taking into 

account the above facts, the accounting equation can be re-written as follows: 

Assets = Liabilities + (Capital +Income - Expenditure) 

Each component of the above equation can be classified into groups of accounts as 

follows: 

Note: In Computerised Accounting grouping of accounts is based on Accounting 

Equation. Grouping is the process of classifying accounts of similar nature under one 

head.  

ASSETS 

 Fixed Assets 

❖ Land and Building 

❖ Plant and Machinery 

❖ Furniture and Fittings 

❖ Vehicles 

❖ Others 

Current Assets 

❖ Cash 

❖ Bank 

❖ Debtors 

❖ Stock 

❖ Bills Receivables 

❖ Loans and Advances (Assets) 

LIABILITIES 

 Long term Liabilities 

❖ Debentures 
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❖ Loans from Financial Institutions 

Short term Liabilities 

❖ Short term Loans 

❖ Creditors 

❖ Bills Payable 

❖ Provisions 

CAPITAL 

❖ Share Capital 

Reserves and Surplus 

❖ Capital reserve 

❖ General Reserve 

❖ Balance of Profit and Loss Account 

❖  

Income (Revenue) 

❖ Sales 

❖ Other Income 

Expenses 

❖ Raw materials consumed 

❖ Manufacturing Expenses 

❖ Wages 

❖ Salaries 

❖ Depreciation 

Codification of Accounts 
In CAS, codification is the process of allotting codes to various accounts.. In CAS code 

is given to groups and ledgers for the purpose of sorting. Code may be a symbol, 

alphabet or number allotted to a particular item for easy identification. Codification is 

the essence of computerized accounting system. 

We can give 1st digit ‘1’ for ASSETS,’2’ for LIABILITIES,’3’ for INCOME, ‘4’ for 

EXPENDETURE etc.Codification is the essence of computerized accounting system. 

Here codes are necessary because the computer cannot understand that whether the 

item is an expense, income, assets or liability. 

For  assets we can give 2nd digit ‘1.1’ for fixed assets and ’1.2’ for Current assets. 

For  liabilities we can give 2nd digit ‘2.1’ for Long-term liabilities and ‘2.2’ for Current 

liabilities. 

Finally, 3rd digits may be used to identify various accounts under appropriate group.For 

example Land and Building. It is an asset; also it is an example for fixed assets. So 
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we can give the code ‘1.1.1’. Like we can give ‘1.1.2’ to another fixed asset Plant and 

Machinery. 

Eg.Cash-1.2.1, Debtors-1.2.2, Bills receivable-1.2.3 

Eg.Creditors-2.2.1,Bills payable-2.2.2,Outstanding expense-2.2.3 

Different types of codes 

1.Sequential codes 
In this method numbers, letters or combination of both are assigned in consecutive 

(uninterrupted) order. These are used primarily to source documents such as, cheques 

invoices, vouchers; etc.This type of codification makes easier the document search. 

Eg.001, 002, 0003, 004,005 or CA001, CA002, CA003, CA004 etc.……. 

2.Block codes 

In a block code, a range of numbers is divided into a desired sub- range and each sub-

range is allotted to a specific group. An example will make clear this method of 

codification. 

GROUP CODE ITEMS  

100-199 Biscuits 100-good day,101-Parle G,102-Marie Gold 
200-299 Chocolates 200-Perk,201-Bar One,202-Dairy Milk 
300-399 Soft drinks 301-Pepsi,302-Coca Cola,303-Mirinda 
400-499 Fruits 400-Orange,401-Apple,402-Pineapple 

 

3.Mnemonic Codes 

This type of coding uses  alphabets or abbreviations as symbols to represent a piece 

of information. For example TVM for Trivandrum, TDPA for Thodupuzha, SJ for sales 

journal, PJ for purchase journal etc. 

Methodology to Develop Coding Structure and Coding 
We use code in many fields. Many accounting softwares use code to identify accounts. 

Examples are register number for examination, pin code at our post office, bank IFSC 

code etc. There are several things to consider while designing a code. Explain the 

codification process with the help of an example. Let us see how the student roll 

number is assigned for the public exam. 

The hierarchy of the roll number will be as follows: 

School-------Course---------Class-----Second Language-------Class Number 

Coding Structure will be as follows: 
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1) School code-4 digits (total number of higher secondary school is 1845,i.e.below 

10000,so 4 digits) eg.6039 

2) Course code- 2 digits (there are 48 streams) eg.03 

3) Class – digit (1 for first year and 1 for 2nd year) eg.1 

4) Second Language – I digit (there are 4 second languages) eg.1 

5) Class number of students- 2 digit (max class strength 60) eg.22 

 Roll No-6039031122 

Merits/ Advantages of Computerised Accounting System (CAS) 

1. Timely generation of reports and information is possible in CAS. 

2. Storage and retrieval of data is very easy in CAS. 

3. Accurate and updated information is possible in CAS 

4. Automated document preparation is possible in CAS. 

5. Confidentiality of data can be easily maintained in CAS 

6. Alterations and additions in transactions can be effected easily  in 

computerized accounting 

7. Simplicity: In CAS, the job of an accountant is only to enter accounting 

transactions through appropriate vouchers. All other functions will do by 

the computer itself.  

8.  Most of the accounting packages are complete and comprehensive. They 

can handle various types of vouchers, day books, different registers, final 

accounts etc. 

 Demerits/Disadvantages of computerized accounting system 

1. Costly 

Computerised accounting system software is expensive. Cost due to obsolesce 

of technology, training cost of employees etc. are also high. 

 2. Lack of reliability 

 Computer viruses and hackers may destroy all data stored in the computer 

 system. So, we can’t be trusted completely on computerized accounting 

 system. 
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 3. Human Error 

 Speedy recording of data in accounting software may result serious errors. 

 4. Lack of knowledge  

 Lack of experienced staff is one of the limitations of computerized accounting. 

 Proper training to staff is compulsory. It is costlier. 

5. Chances of data loss due to various reasons. 

 

 

Plus, Two Accountancy, Expected Questions Based on Focus Area 

Part-B Chapter-1   

 Overview of Computerised Accounting System 

1. Codes using alphabets or abbreviations (TDPA for Thodupuzha) are called----- 

[Mnemonic codes] 

2. Give an example for block code……. [100-199] 

3. CD-1,CD-2 or 1,2,3… etc are example for…….code. (Sequential code) 

4. The processed data is called….. [Information] 

5. Unprocessed facts are called------  [Data] 

6. Cash account and bank account will come under……...group.   [Current Asset] 

7. Sulthan Bathery is represented as ‘SBY’. Identify the type of code. 

  [Mnemonic Code] 

2. What are the components of Computerised Accounting System [CAS]. 

Ans: Procedures, Data, Users, Hardware, software 

3. The process of classifying the accounts of similar nature into one place is called 

---    [Grouping] 

4. Program to perform a particular task on a computer is called ….. 

[Software] 

6. Two advantages/merits of computerised Accounting System? 

[Instant and automatic processing of transactions, saves times and money, 

Storage and retrieval of data is very easy, Accuracy, Voucher and cheque 

printing is possible, transparency and reliability ensured (any two)] 

7. Distinguish between Data and Information? 

Data: Data are raw facts that are stored in a computer. It is unorganized facts 

so it needs to be processed. 

Example: Each business transactions are example for data. 

Prepared by, BINOY GEORGE, HSST, MKNM HSS, Kumaramangalam, Thodupuzha, Idukki Dt. 



HSE-II Computerised Accounting  Chapter-1 

05-01-2021 9 Binoy George 

Information: Processed data is known as information. 

Example: In a business there are numerous transactions. CAS processed these 

data and provide information in the form of gross profit, net profit, ledger 

account balance etc. 

8. Two limitations of computerised accounting system? 

[It is Costly, Lack of skilled personnel, Computer viruses and hackers may 

destroy all data stored in the computer system, huge training cost of 

employees, faster obsolescence of technology, lack of technological 

knowhow, Speedy recording of data in accounting software may result 

serious errors, Lack of experienced staff is one of the limitations of 

computerized accounting. (Any two)] 

8. What is codification and what are the different types of codes? 

In CAS, codification is the process of allotting codes to various accounts. Code 

may be a symbol, alphabet or number allotted to a particular item for easy 

identification. 

Types of codes: 

a. Sequential codes: In this method numbers, letters or combination of both 

are assigned in consecutive (uninterrupted) order. Example:1,2,3….or 

C1,C2,C3 

b.Block codes: In a block code, a range of numbers is divided into a desired 

sub- range and each sub-range is allotted to a specific group. Example:- 

GROUP CODE ITEMS 

100-199 Biscuits 

200-299 Chocolates 

300-399 Soft drinks 

400-499 Fruits 

c.Mnemonic Codes 

This type of coding uses  alphabets or abbreviations as symbols to represent a 

piece of information.  

For example TVM for Trivandrum, SJ for sales journal, PJ for purchase journal 

etc. 

9. What are the important features of CAS? 

1. Simplicity: Computerized Accounting System (CAS) is an easy way to process 
the accounting transactions.  

2.Comprehensive nature: Most of the accounting packages are complete and 
comprehensive.  
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3. Accuracy: The reports that are generated by computerized accounting 
system are free from mistakes.  

4. Speed: Computers can process data millions of times faster than human 
beings. 

5. No difficulty in alterations: Alterations and additions in transactions can be 
affected easily in computerized accounting.  
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Chapter 2 

Spreadsheet 

(Focused Area Only) 

 

 

 

 

 

 

Spreadsheet is a large sheet comprising several Rows and Columns for data manipulation. It 

is used to record, calculate and compare numerical or financial data. It is an application 

software. The data stored can be arranged and analysed with the help of different functions 

and formulae. Spreadsheet provides the facility to draw various graphs like bar, pie, etc. 

Example for Spread Sheets: LibreOffice Calc, MS-Excel, Lotus 123, Open Office Spread 

Sheet, Quattro  

LibreOffice Calc 

LibreOffice Calc is a spread sheet package that we can use to calculate, analyse and 

manage data. LibreOffice Calc is available in variety of platforms including Linux, Windows 

and macOS. LibreOffice is a Free and Open Source Software (FOSS) 

Open LibreOffice Calc 

Application-----Office----LibreOffice Calc 

Features of LibreOfficeCalc/ Spread Sheet 

1) Easy Calculations 

In LibreOffice Calc, there are lot of tools which help the user to perform even 

complex calculations on different data across sheets with ease. 

2) Arranging Data 

The data stored in LibreOffice calc can be organised or reorganised according to the 

needs of the user. 

3) Serve as Database 

This programme allows storing any amount of data in different sheets. Storing, 

retrieving, filtering etc. are easy in it. 

4) Dynamic Charts 

Different types of charts are available in LibreOffice Calc and are enable the user to 

present various data in an appealing manner. 

Chapter-2 Focused Area 2022 Examination 

1. Features of LibreOffice Calc 

2. Components of LibreOffice Calc 

3. Spread Sheet Operations 

4. Cell References 

5. Functions (Date and Time, Statistical, Logical and Mathematical 
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1. Title bar: File Name displayed here. 

2. Menu Bar: Various features of the software displayed here. 

This menu contains items to create a new document, save a document, to 

access templates and wizards. 

3. Standard Tool bar: Here tools like sort, cut, copy, save, spelling etc are 

arranged.  Standard Toolbar gives the user access to file operations, printing 

etc. 

4. Formatting Tool Bar: The formatting toolbar is a toolbar that gives the user 

the ability to change the formatting of selected text. Various tools like font 

size, bold, underline etc arranged here. 

5. Active Cell: the selected, highlighted, or clicked-upon cell is called the active 

cell. Data entry takes place only in an active cell. 

6. Name Box: This is the place where the active cell’s address is displayed. 

Displays the reference for the current cell, the range of the selected cells, or 

the name of the area. 

7. Formula Bar:  It shows the contents of the current cell and allows you to 

create and view formula. 

8. Column Header: Name of the column displayed here. Columns are named by 

alpha characters like A, B...AA,AB,..and ended with AMJ. In LibreOffice Calc there 

are 1024 columns. 

9. Row Header: Name of the row displayed here. Rows are named by numbers 

like 1, 2, 3 etc. In LibreOffice Calc there are 1048576 rows. 

10. Sheet Tab: Sheet tab shows the sheets in a work book. Here the user can rename, 

move, delete and copy a work sheet. 
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11. Status Bar: The Status Bar is located on the bottom of your document 

page.It's not a toolbar Displays the number of the current sheet, the total 

number of sheets in the spreadsheet, current Page Style etc. 

 Work book 

A file in spread sheet is known as work book. A work book is a collection of number of work 

sheets.  

Work sheet 

Each page in the work book is called work sheet.  

Spreadsheet Operations 

1) Open Work Book 

While being on the LibreOffice Calc, you can open a new workbook by choosing ‘New’------

‘Spreadsheet ’option from the File Menu. While being on the LibreOffice Calc, you can open 

a existing workbook by choosing ‘open ‘option from the File Menu and select the required 

workbook. 

2) Save a Work Sheet 

It is necessary to save all the files in the computer when your work is completed.’Save As’ 

option in the File Menu enables you to save a workbook with a suitable name to the 

computer  

3) Close Work Book 

After you finish works in a workbook, you can close the workbook with ‘Close’ option from 

‘File’ menu. 

4) Insert a new work sheet  

Click the tab at the exact position (plus symbol) on the bottom of the present work sheet or 

right click on the sheet tab--------Insert sheet. 

5) To delete a work sheet 

Click on the work sheet tab which you want to delete ----- Right click----Delete Sheet----Ok 

6) To rename a worksheet 

Click on the name of the work sheet tab (say, sheet 1) you want to rename -----Right 

click-------Enter the new name---- ----Ok 

7) To copy / move a work sheet 

Click on the work sheet tab which you want to copy--------Right click-----select move or copy-

-------- select the sheet insert before ------- ok 
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3.Statistical Function 
Statistical function helps in report generation. It operates on a set of data and gives 

summarised results.Important statistical functions are: 

1. AVERAGE( ) 

2. MINIMUM( ) 

3. MAXIMUM( ) 

4. COUNT() 

5. COUNTA() 

6. COUNTBLANK() 

7. COUNTIF() 

 

1) AVEREGE ( ) 

Syntax=AVERAGE(Number1,number2,...) 

This function is used to find out average values (Arithmetic mean)  in a range of cells. 

2) MINIMUM Function/ MIN( ) 

The minimum function in LibreOffice Calc is used to find out lowest values in a range of 

cells. 

Syntax=MIN(Number1,Number2,...) 

 

 

 

 

 

 

 

 

3) MAXIMUM Function/ MAX( ) 

The maximum function in LibreOffice Calc is used to find out lowest values in a range of 

cells.  Syntax=MAX(Number1,Number2,...) 
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Eg;=COUNTA(45,78,HK,46,AF,23,89) + Enter, Returns  7. 

6) COUNTBLANK ( ) 

COUNTBLANK functions counts the number of empty cells in a given range. A cell that 

contains formula is not treated as empty, even if its result is empty. 

Syntax=Countblank(range) 

Refer the above example,A9=Countblank(A1:F7).The result will be 9.The reason is that out 

of 35 cells only 9 cells  remain blank. 

 

 

 

 

 

 

 

7) COUNTIF ( ) 

Count if function is used to count the number of cells in a range that meet a given 

condition or criteria. The criteria can be a number (10), text string(Hindu), expression(>) 

etc.  

Syntax=Countif(range,”criteria”) 

Range: Range to which criteria are to be applied. 

Criteria:It can be a number,expression,cell reference or a character string. For eg.,criteria 

can be expressed as 7000,”>50”,”Thodupuzha”,C2 etc. 

Note.If you search for literal text enclose the text in double quotes (“ “) 

Eg.The following Excel worksheet shows personal details of students in a saksharatha class. 
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A8=Countif(A2:G6,”KALAYANTHANI”),the result will be 2.The reason is that the text string 

“KALAYANTHANI”occurs 2 times in the above sheet. 

Refer the above example 

=Countif(A2:G6,”MANAKKADU”) The result will be 1, the reason is “MANAKKADU”occurs 
two times in the table. 

=Countif(B2:B6,”>=21”) The result will be 4, the reason is that there are 4 values 
which are greater than or equal to 21. 

=Countif(A2:G6,”=45”) The result will be 1; the reason is that there is only one 
value which is equal to 45. 

= Countif(G2:G6,”<65”) The result will be 2; the reason is that there are 2 values 
which are less than 65. 

Example: 

A1:A10 is a cell range containing the numbers 2000 to 2009. Cell B1 contains the numer 

2006.In cell B2,C2 and D2 enter these formula: 

=COUNTIF (A1:A10,2006) – Returns 1 

=COUNTIF (A1:A10,B1) – Returns 1 

=COUNTIF (A1:A10,”>=2007”) – Returns 8 

 

 

 

 

 

 

FUNCTION COUNT 

COUNT() It counts the number of cells in range 
that contains both number and date 

COUNTA() It counts the number of cells that contain 
any type of value. 

COUNTBLANK() It counts the number of empty cells in 
the given range. 

COUNTIF() It counts  the number of cells within the 
given range that meet the given 
condition or criteria 

4. LOGICAL FUNCTION 
Logical functions help to compare more than one condition and outcome. Logical functions 

return only one of two values: True or False. Logical function requires the usage of logical 

operators. There are number of logical operators such as =,> (greater than), <(less 

than),>= (greater than or equal to),<=(less than or equal to),<>(not equal to)  etc. 

Eg:=IF(A1<20,”Yes”,”No”)this function will return Yes if cell A1<20 and 0 for  anything else. 
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Score Grade 

90-100 A+ 

80-89 A 

70-79 B+ 

60-69 B 

50-59 C+ 

40-49 C 

30-39 D+ 

Less than 30 D 

 

Procedure: Step-1 Open a new spread sheet in LibreOffice Calc 

Step-2 Type the labels 

SUBJET-A1 

SCORE-B1 

GRADE-C1 

Step-3 

Enter the details given in the question in respective cells. 

Step-4 Enter the formula in cell C2 

C2=IF(B2>=90,”A+”,IF(B2>=80,”A”,IF(B2>=70,”B+”,IF(B2>=60,”B”,IF(B2>=50,”C+”,IF(B

2>=40,”C”,IF(B2>=30,”D+,”D”))))))) 

Then select the cell C2 again and drag from C2 to C7. 

 

 

 

 

 

 

Q.The yearly sales of 6 salesmen are given below: 

employee name sales 

Alen 28000 

Balan 8000 

Rajan  11000 
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Mohan 45000 

Venu 32000 

Salim 52000 

Calculate the commission earned by each salesman on the basis of the percentage 

given in table 

Yearly Sales Commission(% on 
sales) 

<10000 0% 

>=10000 to<20000 5% 

>=20000 to<30000 10% 

>=30000 to<50000 15% 

>=50000 18% 

Procedure: 

Nested IF is the appropriate  function to calculate the above commission 

Step-1 Application---------office-----LibreOffice calc 

Step-2 Type the column head as 

A1- Employee Name 

B1-Sales 

C1-Commission 

Enter the employees name in the range A2:A7 

Enter the sales figures in the range B2:B7 

Step-3 Calculate commission in cell C2 by applying the formula  

C2=IF(B2<10000,B2*0%,IF(B2<20000,B2*5%,IF(B2<30000,B2*10%,IF(B2<50000,B2*1

5%,IF(B2>=50000,B2*18%))))) 

 

 

 

 

 

 

 

2) AND 

 Returns TRUE if ALL arguments are TRUE. It checks more than one condition and if 

any argument is FALSE, returns FALSE. 
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Step-2 Enter the details given in the question in respective cells 

Step 3 Select the cell E2 and enter the formula 

E2=IF(AND(B2="Male",C2>=18,D2<=66),"Selected","Not Selected") +Enter .Select E2 

again and drag 

 

 

 

 

   

 

3) OR Function 

OR Function tests a number of supplied conditions and returns TRUE if at least one 
argument is TRUE; returns FALSE if all arguments are FALSE. 

 The difference between OR and AND is that OR will return TRUE if atlest one argument is 
correct but AND will return TRUE only when all arguments must be correct. 

 OR (logical Value 1, logical Value 2..........) 

Returns TRUE, if at least one argument is TRUE, returns FALSE if all arguments are 

FALSE. 

Syntax=OR(logical Value 1,logical Value 2..........) 

Syntax Description Result 

=OR(5>9,15>13,23<20) If at least one argument is 
True, returns True 

TRUE 
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4. Dearness Allowance (DA): It is based on the cost of living index released by the 

Government from time to time. In other words, it is a compensation to make up the 

purchasing power of wage earners due to price increase.(DA=BP/BPE*Applicable rate 

of DA) 

5. House Rent Allowance (HRA): It is an amount paid to an employee to facilitate him in 

getting rented accommodation. (HRA=BP/BPE*Rate of HRA for the month.) 

6. Transport Allowance (TRA): This is an amount paid for conveyance to the work 

place.(Fixed amount or Percentage) 

7. City Compensatory Allowance (CCA): This is a special allowance paid to employees 

who live in cities. In cities there are more costs of living as compared to rural 

areas.(Fixed amount or Percentage) 

8. Any Other Allowance: It includes education allowances, medical allowances, washing 

allowances etc. 

2. Deductions 

1. Provident Fund: It is statutory deduction decided by the government from time to 

time under Provident Fund Act. It is computed as certain percentage of Basic Pay 

plus DA, if applicable.(PF=BP*Rate of PF) 

2. Professional Tax (PT): This is a deduction as per the legislation of the state 

government.(It is usually a fixed amount) 

3. Tax Deducted at Source (TDS): It is statutory deduction made towards income tax 

liability of an employee. It can be deducted monthly or yearly. (It is usually a fixed 

amount) 

4. Recovery of Loan Instalment: This is the instalment amount of any loan taken by 

the employee from the organisation. (It is usually a fixed amount) 

5. Any other Deduction: This may include ‘Festival Advance’, ’Medical Advance’ etc 

Payroll  Statement 

Q.1 

Calculate Net Pay from the following particulars of employees in Excel Traders, 

prepare the Payroll Statement. 

Name Basic Pay (BP) 

Biju 10000 

Suresh 7000 

Surendran 6500 

Monichan 4500 

George 6500 

Manju 7500 

Radhakrishnan 6850 

Sumi 7580 

Saji 6150 

Tiju 8800 

Additional Information: 

1. DA 50% of BP 

2. HRA 10% of BP 

3. Monthly subscription to PF 

5% of BP 

4. Group Insurance Premium 

Rs 150 from each employee. 

 



   

    
 

 

 

 Procedure:  

Step 1 Open a new work sheet. 

Step 2: Enter the column head as: 

Name: A1 

Basic Pay: B1 

DA: C1 

HRA: D1 

Gross Pay: E1 

PF: F1 

GI: G1 

Total Deduction: H1 

Net Pay: I1 

Step 3 Enter the Name of first employees ‘Mohan’ in A2 and his BP 8650 in B2. Similarly 
enter the name and BP of remaining nine employees in the respective cells 

Step 4 Enter DA, HRA, Gross Pay, PF, GI, Total deduction and Net pay of the first 
employee as given below 

Cell A2 B2 C2 D2 E2 F2 G2 H2 I 2 
Content  Biju 1000

0 
= B2*50% =B2*10% =B2+C2+=D

2 
=B2*5% 150 =F2+G2 =E2-H2 

Step 5 Fill down the calculation to remaining employees 

a. Select the range C2 to I 11 

b. Click the (Edit menu) - Fill – Down OR Select the range C2 to I 11+ ( Ctrl+D) 

c. The calculations of remaining nine employees are then filled automatically 

Output 
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Q2.Prepare Payroll of the following Employees: 

Name Basic Pay PF Loan 

Sabu 28000 10000 

Ajayan 42000 12800 

Usha 44500 14300 

Sanjo 64000 0 

Binil 48000 12700 

Jos 48000 11850 

James 43500 12000 

Arjun 68000 0 

Roy 37500 12000 

Anna 58000 6500 

Additional information: 

1. DA 38% of Basic pay. 

2. HRA Rs.1250 for Employees Basic pay greater than Rs.54000, for others Rs.1000. 

3. TA Rs.500 per Employee. 

4. PF subscription 15% for BP. 

5. TDS 18% for GP greater than Rs.60000, otherwise12%. 

Procedure:  

Step 1 Open a new work sheet. 

Step 2: Enter the column head as: 

Name: A1 

Basic Pay: B1 

DA: C1 

HRA: D1 

TA: E1 

Gross Salary: F1 

PF subscription: G1 

TDS: H1 

PF Loan: I1 

Total Deduction:J1 

Net Salary: K1 
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Step 3 

Enter the Name of first employees ‘Sabu’ in A2 and his BP 28000 in B2. Similarly enter the 

name and BP of remaining nine employees in the respective cells. 

Step 4, Select the cell C2 and enter the formula,C2=B2*38% 

Step 5, Calculate HRA in cell D2 ,D2=IF(B2>54000,1250,1000) 

Step6, Type TA Rs.500 in cell E2 and select the rang E2:E11,EDIT-------FILL-----DOWN. 

Step 7, Calculate Gross Salary in cell F2,F2=B2+C2+D2+E2 

Step8, Calculate PF Subscription in G2 ,G2 =B2*15%  

Step-9, Calculate TDS in H2,H2=IF(F2>60000,F2*18%,F2*12%) 

Step-10, Enter PF Loan amount given in the question in respective cells. 

Calculate Total Deduction in Cell J2,J2=G2+H2+I2 

Calculate Net salary in cell K2,K2=F2-J2 

Fill down the calculation to remaining employees 

a. Select the range C2 to I 11 

b. Click the (Edit menu) - Fill – Down OR Select the range C2 to K 11+ ( Ctrl+D) 

c. The calculations of remaining nine employees are then filled automatically 
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Asset Accounting  

Asset Accounting covers the complete life cycle of an asset. It involves maintenance of 

asset register, computation of depreciation etc. The inbuilt functions of LibreOffice calc 

make the asset accounting easier. 

Calculation of Depreciation 

Depreciation means the gradual and permanent decrease in the value of fixed asset. 

Depreciation may arise due to wear and tear, passage of time, obsolescence through 

technology or market changes. It is considered as revenue expenditure. The net result of 

depreciation is that the asset becomes useless after some period and its value either 

reduces to zero or to a very nominal figure. Asset accounting means maintain assets 

register by considering the depreciation of the asset. 

Basis of Providing Depreciation 

 The following factors are usually taken into consideration for calculating the amount 

of depreciation: 

a) The original cost of the asset including installation charges. 

b) The estimated working life of the asset. 

c) The estimated residual or scrap value. (The value of the asset will obtain at the time 

when it will be replaced) 

Methods of calculating Depreciation 

Mainly there are two methods for calculating depreciation. They are; 

1. Straight Line Method (SLN)  

2. Diminishing Balance (DB) method. 

1.SLN () 

In LibreOffice Calc there is a simple function called SLN() to calculate depreciation for a 

year under Straight Line Method.The syntax of SLN Function is 

 =SLN(Cost,Salvage,Life) 

Cost= Cost of acquisition of asset 

Salvage= Scrap value at the end of asset’s life. 

Life=Estimated life of the asset. 

Q. M/S Anjaly Traders purchased a plant on 1/1/2006 for Rs 1,50,000 and an amount of 

Rs 6000 spent for the installation of the plant. The life time of the plant is estimated to be 

10 years and the scrap value is estimated as Rs 1,000.Calculate depreciation under SLN. 

Depreciation==SLN(Cost,Salvage,Life) 

Cost= Cost of acquisition of asset ,1,56,000 (150000+6000) 
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A1 Name B1 Machinery 

A2 Date Purchase B2 01-11-2013 

A3 Cost B3 310000 

A4 Salvage B4 20000 

A5 Life B5 10 

A6 Period B6 4 

A7 Month B7 5 

A8 Depreciation(DB) B8 ₹ 38,676.10 

 
Step-3 Select the cell B8 
 B8=DB(B3,B4,B5,B6,B7) 
 
Out Put: 
 
 
 
 
 
 
 
 
 
 
 
 

 

 ********************* 

 

Prepared by, BINOY GEORGE, HSST, MKNM HSS, Kumaramangalam,Thodupuzha, Idukki Dt. 
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Q.The  following table shows  sales figures of salesmen  Mr.Vinod and Mr.Thomas in Anju 
Traders for the year 2013 to 2017  
 

YEAR VINOD THOMAS 

2013 22000 12000 

2014 14000 2800 

2015 12000 18000 

2016 15150 4800 

2017 25000 20500 

 
Q.1 present the data in a column chart. Q.2 Change the chart type to line chart  
 
Procedure: 
Q.1 

Step-1 Data Entry 

 Open a new work sheet in LibreOffice Calc and enter the details in respective cells.  

 

 

 

 
 
 
 
 
 
Step-2 Chart Creation 
Select the range (here it is (A1:C6). Then select 

 Insert----Chart--------Select a suitable Chart Type (here column chart) --------Next 

 
Step-3 Data Range (Normally no change required) -------Next------Data Series-------

(Normally no change required) ------Next 

Step-4 Chart element Management 

Here Enter the details of chart elements: 

 Here user can give suitable title, subtitle, X-axis title,Y-axis title etc for the chart 
 

Title Sales Figures of Anju Traders 

Subtitle Sales Performance 

X axis Title YEAR 

Y axis Title Rs. 

 



  Chapter-4 

28-12-21  136  Binoy George 
 

 
 
Click ------- Finish 
 
Output: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Change the chart type to line chart 
 
  Click on the already prepared column chart----Right click-----Select Chart type------
Select Line Chart-----Line Only----OK  
(OR select ‘Format’------chart type----line chart) 
 
Output (2): 
 
 
 
 
 
 
 
 
 
 
 

Pie Chart 
 
 
Q2. Draw a pie chart for the following data on vehicles registered in the Motor Vehicles 
Department during 2017-18 in Kottayam city. 
 

Vehicle Type Bus Trucks Auto Cars 
Two 
Wheelers 

Heavy 
Vehicles 

No of Vehicles 603  403  11234  8456  25407  89 

 
Procedures: 
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   Step 1. Open a new worksheet in LibreOffice calc and enter the details given in the 
question in respective cells. 
 
 
 
 
 
 
 
 
  Step-2 Chart Creation 
Select the range (here it is (A1:G2). Then select 

 Insert----Chart--------Select a suitable Chart Type (here Pie chart) --------Next 

Step-2 Data Range-----Next------Data Series-----Next------Data 

Step-3 Chart Element Designing 

Here Enter  

Chart Title as- Vehicles Registered during the year 2017-18 

Subtitle as- Kottayam city 

 
 

 
 
 
 
 
 
 
 
 
 
 

A created chart can be formatted with the help of ‘Format’ Menu. To format a chart, first 

Double Click the chart so that it is enclosed by gray border (indicating edit mode) -------

select ‘Format’ menu-----then select the chart element you want to format. 

To change chart area background Format----Chart area 

To change chart type Format----Chart Type 

To chart graphics background Format----Chart Wall 

Usage of different types of chart-An Analysis 

Line Chart This type of chart is normally used for explaining trends 
over periods 

 

 

Normal Pie Chart 
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Area Chart Area charts are very similar to line charts, but the former 
ones have solid plot lines. Area charts are ideal for 
displaying trends over a period for single or several 
categories, or the change between several data groups. 

Radar Chart Spider and radar charts are also known as web charts, 
star charts or polar charts. If you have a large set of 
different data groups, using spider and radar charts are 
better than column ones. 

Pie Chart Pie charts are generally used to display data as a 
percentage of the total 

Column Chart Column charts are a good way to show change over time 
because it's easy to compare column lengths. 

Bar Chart Bar charts are excellent for charting multiple values over 
extended durations 

  

Prepared by, BINOY GEORGE, HSST, MKNM HSS, Kumaramangalam, Thodupuzha, Idukki Dt. 


